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1750 
Power Recorder 

Introduction 
XW Warning 

To avoid electric shock or personal injury, do not perform the 
calibration verification tests or calibration procedures 
described in this manual unless you are qualified to do so.  
The information provided in this manual is for the use of 
qualified personnel only.  

The 1750 Calibration Manual provides the following information: 

• Precautions and safety information 

• Specifications 

• Basic maintenance 

• Calibration procedures 

• Verification procedures 

• Replaceable parts and accessories 

For complete operating instructions and calibration software, refer to the 1750 Users 
Manual CD. 

Contacting Fluke 
To contact Fluke, call: 

1-888-993-5853 in USA  
1-800-363-5853 in Canada 
+31-402-675-200 in Europe 
+81-3-3434-0181 in Japan 
+65-738-5655 in Singapore 
+1-425-446-5500 from anywhere in the world 

Or, visit Fluke’s Web site at www.fluke.com  

To register your product, visit http://register.fluke.com 
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To contact Technical Support: 

fpqsupport@fluke.com  

or 888-257-9897 (US only) 

Safety Information 
The 1750 Power Recorder (hereafter referred to as the Recorder) complies with  
EN 61010-1 600 V CAT IV, 1000 V CAT III overvoltage rating. See Specifications for a 
full agency compliance list. 

XWWarning 
To avoid electrical shock, personal injury, or fire: 

• Review the entire manual before using the Recorder and its 
accessories and observe all warnings and cautions. 

• Do not perform the calibration verification tests or 
calibration procedures described in this manual unless you 
are qualified to do so. 

• Avoid working alone. 

• Do not operate the Recorder around explosive gas or 
vapor. 

• Use only insulated current probes, test leads, and adapters 
as supplied with the Recorder, or indicated as suitable for 
the Recorder. 

• Before use, inspect the Recorder, voltage probes, current 
probes, leads, and accessories for mechanical damage, 
and replace when damaged. Look for cracks or missing 
plastic. Pay special attention to the insulation surrounding 
the connectors. 

• Remove all probes, test leads, and accessories that are not 
in use. 

• Make sure the Recorder is properly connected through the 
power cord to protective earth ground. 

• Do not apply input voltages above the rating of the 
Recorder as shown on the input panel. 

• Do not apply voltages in excess of the marked ratings of 
the voltage probes and current probes. 

• Use caution if exposed metal BNC or banana plug 
connectors are used for calibration. Avoid applying voltage 
to the shell of the BNC during calibration. 

• Do not insert metal objects into connectors. 

• Never open the Recorder’s enclosure, dangerous voltages 
are present. There are no user-replaceable parts in the 
Recorder. Refer servicing of internal parts to qualified 
service personnel. 

• Use the Recorder only as specified in this manual, or the 
protection provided by the Recorder may be impaired. 
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Symbols 
Symbols used in this manual and on the Recorder are listed in Table 1. 

Table 1. Symbols 

X Hazardous voltage. Risk of electrical 
shock.  

W Risk of danger. Important information. See 
manual.  

) Canadian Standards Association.  
[ Note: Canadian and US. ] 

. Protective conductor terminal. 

CAT III 

CAT III equipment is designed to protect 
against transients in equipment in fixed-
equipment installations, such as 
distribution panels, feeders and short 
branch circuits, and lighting systems in 
large buildings. 

CAT IV 
CAT IV equipment is designed to protect 
against transients from the primary supply 
level, such as an electricity meter or an 
overhead or underground utility service. 

~ Do not dispose of this product as unsorted municipal waste. Go to Fluke’s web site for recycling 
information. 

Specifications for the System: Recorder and Power Analyze 
Software 

General Specifications 
Power Quality Measurement Standards  

Conformance ..................................................... IEC 61999-1-4 Class 1, IEC 61000-4-30 Class A or B depending on 
measurement function, IEEE519, IEEE1159, IEEE1459 

Clock/Calendar .................................................. Leap years, 24-hour clock 

Real-time Clock Accuracy ................................ Not more than ± 1 s/day 

Internal Memory Capacity for Data ................. At least 1 GB 

Maximum Recording Period ............................ At least 31 days 

Measurement Time Control ............................. Automatic 

Maximum Number of Events ........................... Limited only by the size of the internal memory. 

Power Requirements ........................................ 100 to 240 V rms ± 10 %, 47-63 Hz, 40 W 

Operating Time During Interruptions  

(internal UPS operation) ..................................... 5 minutes per interruption, 60 minutes total operating time without 
recharging 

Dimensions ....................................................... 215 x 310 x 35 mm (8.5 x 12.2 x 3.5 inch) 

Mass (Weight) ................................................... 6.3 kg (14 lbs) 

Input Specifications 
Measurement Types ......................................... One Phase Plus Neutral, One Phase IT No Neutral, One Phase Split 

Phase, Three Phase Wye, Three Phase Delta, Three Phase IT, Three 
Phase High Leg, Three Phase Open Leg, 2 Element Delta, 2 ½ 
Element Wye 

Input Channels .................................................. Voltage: 5 channels, AC/DC 
Current: 5 channels 

Voltage Channels .............................................. Input resistance: 2 MΩ 
Input capacitance: <20 pF 

Current Channels .............................................. 1 MΩ. Self-identifying probes 
Types available: current clamps, Flexi-CTs 

Measuring Method ............................................ Simultaneous digital sampling of voltage and current. Digital PLL 
synchronized sampling, internal frequency reference used during 
voltage drops. 
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Synchronization and Sampling 
PLL-Synchronization Source ........................... The PLL synchronizes to the A-N voltage for wye power types, and to 

the A-B voltage for delta power types. All listed power types can be 
characterized as either wye or delta. 

PLL Lock Range ................................................ 42.5 to 69 Hz 

Sampling Frequency ........................................ Voltage and current: 256 samples/cycle 
Inter-harmonics per IEC61000-4-7: 2560 samples / 10 cycles (50 Hz),  
3072 samples/12 cycles (60 Hz) 
Transient Voltage: 5 MHz 

A/D Resolution .................................................. Voltage and current: 24 bits 
Transient voltage: 14 bits 

Voltage and Current Measurements 
Voltage Measurement Range ........................... AC voltage: 1000 V rms ± 10 % Overrange 

DC voltage: ± 1000 V + 10 % Overrange  

Voltage Crest Factor ......................................... 3 or less 

Voltage Input Impedance ................................. 2 MΩ 

Current Measurement Range ........................... Depends on current probe used 

Current Crest Factor ......................................... 4 or less 

Current Input Characteristics .......................... 2 V rms = full scale, 1 MΩ Input Impedance for ferro CTs, low 
impedance for Flexi-CTs 

Voltage and Current Measurement Accuracy 
RMS Voltage 

Measurement Type ............................................. True rms calculated continuously: every cycle, every 1/2 cycle, and 
every 10 or 12 cycles at 50 or 60 Hz respectively, as required by IEC 
61000-4-30. 

Measurement Uncertainty ................................... AC: ± 0.2 % reading ± 0.1 % full scale above 50 V rms 
DC: ± 0.5 % reading ± 0.2 % full scale above 50 V dc 

If the ac component of a dc signal is below 40 V rms, the dc 
uncertainty specification may have an offset. 

RMS Current 

Measurement Type ............................................. True rms calculated continuously: every cycle, every 1/2 cycle, and 
every 10 or 12 cycles at 50 or 60 Hz respectively, as required by 
standards 

Measurement Uncertainty ................................... ± (0.1 % full scale + 0.5 % reading + current sensor accuracy, valid for  
5 % to 100 % of current sensor range 

 

Current Accuracy ................................................ Ferromagnetic Clamps 
± (0.1 % full scale + 0.2 % reading + current sensor accuracy), valid for  
5 % to 100 % of current sensor range 
Flexible Current Probes 
± (0.1 % full scale + 0.5 % reading + current sensor accuracy), valid for  
5 % to 100 % of current sensor range 

Transient Voltage (Impulse) 
Measurement Type ............................................. Waveshape sampling, not peak detect 

Full Scale ............................................................ 8000 V pk 

Sample Resolution .............................................. 200 nS 

Measurement Uncertainty ................................... ± 5 % reading ± 20 V (test parameters: 1000 V dc, 1000 V rms,  
100 kHz) 

Dip (Sag) and Swell Measurements 
Voltage Swell (rms swell) 

Measurement Type ............................................. True rms (one cycle calculation by overlapping each half cycle) 
(voltage between lines is measured for 3P3W lines and phase voltage 
is measured for 3P4W lines) 

Displayed Data ................................................... Amplitude and duration of swell 
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Measurement Accuracy ...................................... Same as rms voltage 

Voltage Dip (RMS sag) 

Measurement Type ............................................. True rms (one cycle calculation by overlapping each half cycle) 
(voltage between lines is measured for 3P3W lines and phase voltage 
is measured for 3P4W lines) 

Displayed Data ................................................... Amplitude and duration of dip or interruption 

Measurement Accuracy ...................................... Same as rms voltage 

Voltage Dropout (Interruption) 

Measurement Type ............................................. Same as Voltage Dip 

Power and PF Measurement 
Power 

Measurement Method ......................................... Calculated per IEEE1459 for best performance when distortions exist 

Measurement Type ............................................. True rms calculated continuously: every cycle, and every 10 or 12 
cycles at 50 or 60 Hz respectively, as required by standards 

Measurement Accuracy ...................................... ± 0.2 % reading ± 0.1 % full scale + current sensor accuracy 

Frequency 

Measurement Range .......................................... 42.5 to 69 Hz 

Measurement Source ......................................... Same as PLL synchronization source 

Measurement Accuracy ...................................... ± 10 mHz (10 to 110 % of range, with sine wave) 

Reactive Power 

Accuracy ............................................................. ± 0.2 % reading ± 0.1 % full scale + current sensor accuracy 

Power Factor 

Measurement Range .......................................... -1.000 (leading) to 0.000 to +1.000 (lagging) 

Measurement Accuracy ...................................... ± 1 digit from the calculation of each measured value (± 3 digits for 
total) 

Displacement Power Factor 

Measurement Method ......................................... Calculated from the phase difference between voltage fundamental 
and current fundamental 

Measurement Range .......................................... - 1.000 (leading) to 0.000 to + 1.000 (lagging) 

Measurement Accuracy ...................................... ± 0.5 % reading ± 2 % full scale ± 1 digit 

Voltage Unbalance and Phase Sequence 

Measurement Method ......................................... Positive sequence voltage divided by negative sequence voltage, per 
IEC 61000-4-30 

Harmonic Voltage and Current 

Analysis Window ................................................. rectangular 

Analysis Order .................................................... 1st to 50th order 

Measurement Accuracy ...................................... Voltage / Current: 1st to 20th orders: ± 0.5 % reading ± 0.2 % full scale 
21st to 50th orders: ± 1 % reading ± 0.3 % full scale 
(current sensor accuracy must be included for current and power) 

Measurement Method ......................................... IEC 61000-4-7 

Inter-harmonic Voltage and Current (Intermediate Harmonics) 

Analysis Window ................................................. rectangular 

Analysis Orders .................................................. 0.5 to 49.5th order 

Measurement Method ......................................... IEC 61000-4-7 

External Interface Specifications 
LAN Interface 

Connector ........................................................... RJ-45 

Speed and Type ................................................. 10/100 Base-T, auto MDIX 

Communications Protocol ................................... TCP/IP over Ethernet 

Wireless Controller Interface 

Connection .......................................................... wireless (2.4 GHz radio) 

Speed ................................................................. up to 700 kbit/second 

Communications Protocol ................................... Bluetooth SPP 
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Environmental and Safety Specifications 
Operating Environment ....................................... indoors or in covered area outdoors, up to 2000 m altitude 

Storage Temperature and Humidity .................... -20 °C to 50 °C, 80 % rh max, non-condensing 

Operating Temperature and Humidity ................ 0 °C to 40 °C, 80 % rh max, non-condensing 

Maximum Rated Working Voltage 

Voltage Terminals ............................................. 1100 V rms 

Voltage Durability ................................................ 5550 V rms ac for 1 minute, between voltage input terminals, voltage 
input terminals and current probes, and voltage input terminals and 
case (50/60 Hz, 1 mA sense current) 

Enclosure Protection ........................................... IP30 (per EN 60529) 

Standards Conformance 

EMC .................................................................... EN 61326-1:2000 Class A 
EN 61000-3-2:1995+A1:1998+A2:1998 
EN 61000-3-3:1995 

Safety .................................................................. EN 61010-1:2nd Edition 
Voltage input unit: Contamination Level 2 
Measurement Category 1000 V CAT III, 600 V CAT IV (transient: 8 kV) 

Cleaning and Maintenance 
WCaution 

To avoid damage to the Recorder, do not apply abrasives or 
solvents to the housing. 

The Recorder contains no user serviceable parts. Contact an authorized Fluke service 
center for repair. See Contacting Fluke. 

Periodically wipe the case with a damp cloth and mild detergent.  

Required Equipment 
For a list of required equipment for the verification tests and calibration adjustment, see 
Tables 2 and 3. 

Table 2. Required Equipment 

Equipment Required Characteristics Recommended Model 

Calibrator 

AC Voltage Range: 0 - 1000 V ac 
Accuracy: ± 0.03 % 
Frequency Range: 50 - 10000 Hz 
DC Voltage Range: 0 - 1000 V dc 
Accuracy: ± 0.03 % 

Fluke 5520A Multi-Product  
Calibrator or equivalent 

Multimeter with 4-wire Ohms 
Ohms Range: 100 KΩ 
Accuracy: ± 0.011 % 

Fluke 8846A Precision 
Multimeter or equivalent 

Personal Computer (PC) 
(Windows XP) 

1750 Cal Wizard and Fluke Power 
Analyze software installed 
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The cables listed in Table 3 are necessary for verification and calibration adjustment. To 
assemble the cables, see cable assembly figures in the Test Cables section. 

Table 3. Required Cables 

Cable Required Characteristics Notes 

Ethernet cable CAT 5 with RJ-45 connectors Supplied with the Recorder 

Voltage calibration cable 
with BNC-banana adapter 

Double banana to safety banana 
and spade lug 

See Figure 5 

Four jumper cables, safety-
banana type 

  

Current calibration cable 
Shielded cable with double banana 
to CT pins in Redel connector with 
100 A CT ID resistor 

See Figure 6 

Rogowski resistor 
measurement cable 

Safety banana to Redel See Figure 4 

Rogowski calibration cable 
Shielded cable with double banana 
to Rogowski pins in Redel connector 
with 100 A Rogowski ID resistor 

See Figure 3 

Ground calibration cable Lug to banana See Figure 2 

Fluke recommends the use of Pomona brand cables and banana plugs when building these cables. 
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Verification Tests 
XWWarning 

To avoid electrical shock, personal injury, or fire: 

• Do not perform the calibration procedures or calibration 
verification tests described in this manual unless you are 
qualified to do so. 

• Repairs or servicing should be performed only by qualified 
personnel. 

The following tests are used to verify the functions of the Recorder. If the Recorder fails 
any of the verification tests, calibration or repair may be needed. For service, see 
Contacting Fluke. 

Note 
Power Analyze can be set to display the channels as L1, L2, and L3 instead 
of A, B, and C. The channels on the Recorder could also be labeled A, B, 
and C, or L1, L2, and L3, depending on which decal was applied to the 
Recorder front panel. For this manual A, B, and C are used. 

AC Voltage Accuracy Verification 
1. Connect an Ethernet cable to the Recorder. 

2. Apply power to the Recorder. During power up, indicators near all jacks should flash. 

3. Launch Power Analyze software on a personal computer (PC).   

4. Select the Recorder to be tested in the drop down box next to the Scope button.  

5. Select 1750 Live, then Scope.  

6. Check all the voltage display check boxes to the right of the scope display. Make sure 
the correct items are checked. 
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power analyze live view screen.bmp 

Figure 1. Power View Software Live View 

7. Connect the calibrator NORMAL HI to inputs A, B, C, and  of the Recorder. 

8. Connect the NORMAL LO to input N and the protective conductor terminal . of 
the Recorder.  

9. Apply the voltages from Table 4 and list the Recorder readings for channels AN, BN, 
CN, and NG in the appropriate areas. Sine waves will be displayed for AN, BN and 
CN, all at the same amplitude and phase shift. NG will be inverted. 

Note 
If the voltage goes over scale, right click on the voltage scale on the left 
margin of the graphical display, then click on the Zoom to Fit box to 
resize. 

Table 4. AC Voltage Accuracy Verification 

Applied AN Reading BN Reading CN Reading NG Reading Limits 

60 Vrms  @  Local Hz     ± 1.12 V 

240 Vrms  @  Local Hz     ± 1.48 V 

600 Vrms  @  Local Hz     ± 2.20 V 

 

10. Verify that A, B, C, and  LEDs are on. N should be off. 

11. Set the calibrator to STBY.   

12. Verify that A, B, C, and  LEDs are off. 
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Neutral Voltage Verification 
1. Connect NORMAL LO to A, B, C,  , and .. 

2. Connect the calibrator NORMAL HI to N on the Recorder. 

3. Apply the voltages from Table 5, listing the Recorder readings for the appropriate 
model.  

Table 5. Neutral (AC) Voltage Accuracy Check 

Applied NG   Reading Limits 

60 V  @  Local Hz  ± 1.12 V 

100 V  @  Local Hz  ± 1.20 V 

 

4. Verify that the N LED is on.  

5. Set the calibrator to STBY, verify that the LED for N turns off.  

6. Disconnect the test leads from the Recorder. 

Rogowski Current Verification 
1. Verify the resistor in the Rogowski calibration cable is within 0.1 % of 100 kΩ. 

2. Connect the calibrator NORMAL HI to Voltage A, B, and C on the Recorder.  

3. Connect the calibrator NORMAL LO to N and Voltage  on the Recorder. 

4. Connect the calibrator AUX HI and LO to current input A using the Rogowski 
calibration cable. See Figure 3.  

5. Set the calibrator output to 120.0 V @ 55 Hz on the NORMAL output and the values 
from Table 6 the AUX output.  

6. Press the WAVE MENUS softkey and ensure the phase angle is -90 °.   

7. Press the HARMONIC MENU softkey; ensure the HARMONIC selection is set to 
1 and the FUNDMTL selection is set to aux. 

8. Press OPR. 

9. Set the calibrator to voltages from Table 6 and list the Recorder readings for channel 
A. 

10. Move cable to next channel and repeat step 9 for channels B, C, N, and . 
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Table 6. Rogowski Current Accuracy Check 

Applied 

Voltage 

Expected 

Current 

Expected 

Reading 
A   Reading B  Reading C  Reading N  Reading G Reading Limits 

0.649 V 6.49 μA 20 A      ± 0.20 A 

1.6225 V 6.225 μA 50 A      ± 0.35 A 

3.245 V 32.45 μA 100 A      ± 0.60 A 

CT Current Verification 
1. Connect the calibrator NORMAL HI to Voltage A, B, and C on the Recorder.  

2. Connect the calibrator NORMAL LO to Voltage N and  on the Recorder. 

3. Connect the calibrator AUX HI and LO to current input A using the current test 
cable. See Figure 6. The current test calibration cable connects the voltage to all 
current sense inputs and indicates that a 100 A current transformer is attached. 

4. Set the calibrator output to 120.0 V @ 50 or 60 Hz on the NORMAL output and the 
values from Table 7 on the AUX output.  

5. Press the WAVE MENUS softkey and ensure the phase angle is 0.0 °.   

6. Press the HARMONIC MENU softkey; ensure the HARMONIC selection is set to 
1 and the FUNDMTL selection is set to aux. 

7. Press OPR. 

8. Set the calibrator to voltages from Table 7 and list the Recorder readings for that 
channel. 

Table 7. CT Current Accuracy Check 

Applied Voltage 
Expected 

Reading 
A   Reading B  Reading C  Reading N  Reading G Reading Limits 

0.4 V   20 A      ± 0.20 A 

1.0 V   50 A      ± 0.35 A 

2.0 V   100 A      ± 0.60 A 

 

9. Verify that the current LED is on.   

10. Move cable to next channel and repeat steps 8 and 9 for channels B, C, N, and . 

11. Set the calibrator to STBY.  Verify that the current LEDs turn off. 
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Watt Verification 
1. Use the same connections as the CT current verification and apply 440 V and local 

line frequency out of the NORMAL output and 1.9 V on the AUX output. 

2. Click on the power button in Power Analyze. The A, B and C should be 41.8 kW ± 
0.3 kW. 

3. On the calibrator press the blue button for Phase and Ref Menu. 

4. Press the blue button for AUX Phase NRM. 

5. Enter 90 with the numerical keypad and press Enter. The power should be 0 ±  
0.1 kW. 

Impulse Verification 

Initialize the UUT 

XWWarning 
The impulse verification steps instruct the user to apply 
working voltages in excess of 700 V, so extreme caution must 
be applied. To avoid electrical shock or personal injury, DO 
NOT use connectors having exposed metal. 

1. Power down the UUT until Power LED turns off, approximately five minutes. 

2. Power up the UUT and wait for start up, and connect with Power Analyze. 

3. Select Tools>Erase 1750 Memory to empty the UUT data. 

Normalize Thresholds 
4. Connect the calibrator NORMAL LO to the UUT . terminal. 

5. Connect the voltage test cable to the calibrator NORMAL HI jack, leaving the 
safety-connector end free. 

6. Set the calibrator to 750 V 10 kHz. 

7. Press OPR on the calibrator. 

8. Connect the voltage test cable to UUT voltage input  for approximately 15 seconds, 
and then disconnect. 

Apply Stepped Verification Voltages to Voltage Inputs A, B, C, N, and  
9. Set the calibrator to 800 V 10 kHz. 

10. Connect the voltage test cable to UUT voltage input A for approximately 15 seconds, 
and then disconnect. 

11. Set the calibrator to 850 V 10 kHz. 

12. Connect the voltage test cable to UUT voltage input B for approximately 15 seconds, 
and then disconnect. 

13. Set the calibrator to 900 V 10 kHz. 

14. Connect the voltage test cable to UUT voltage input C for approximately 15 seconds, 
and then disconnect. 

15. Set the calibrator to 950 V 10 kHz. 

16. Connect the voltage test cable to UUT voltage input N for approximately 15 seconds, 
then disconnect. 
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17. Set the calibrator to 1000 V 10 kHz. 

18. Connect the voltage test cable to UUT voltage input  for approximately 15 seconds, 
then disconnect. Note, this signal is designated G in Power Analyze. 

19. Press STBY on the calibrator. 

20. Set the calibrator to 0 V 0 Hz. 

To Use Power Analyze to Verify the Amplitude Accuracy of Recorded Impulse Events 
21. Wait two minutes for the UUT to compile event information. 

22. Click on 1750 Download, and then Save. 

23. Click on View Recorded, and then Events. 

24. On the right side, verify that all four Volts selections are checked and all five Amps 
selections are unchecked in Phase Selection, and Phase to Neutral is selected in 
Voltage Reference. 

25. Click on Event Detector. 

26. Select all channels the same and set both AN and the NG thresholds to 50 %.  

27. Click Done. 

28. Click on View > Table View > Top Table View. This changes the Event Summary 
data at the top of the screen from graph-view to table-view. 

29. Click on View > Screen View > Top Full Screen. This provides a full screen view 
of the Event Summary table. 

30. The following steps concern the two right-hand columns in the Event Summary table, 
the Absolute and Triggered Phase columns. 

31. Starting from Event 1, scroll down the table through the NG Triggered Phase data 
until the AN Triggered Phase data is reached. This group of NG Triggered Phase data 
is from the Normalize Thresholds section of this check. It is not used for verification. 

32. Scroll down through the AN Triggered Phase data until the BN Triggered Phase data 
is reached. Record the sixth-to-last AN Triggered Phase Absolute value in Table 8. 

33. Scroll down through the BN Triggered Phase data until CN is reached.  

34. Record the sixth-to-last BN Triggered Phase Absolute value in Table 8. 

35. Scroll down through the CN Triggered Phase data until N-triggered data is reached. 
Because voltage events on N cause triggers on AN, BN, CN, and NG, (resulting in 
any one of these labels) this can be most easily distinguished by the change in the 
Absolute values from the CN Triggered Phase data. Record the sixth-to-last CN 
Triggered Phase Absolute value in Table 8. 

36. Scroll down through the N-triggered data until G-triggered data is reached. As with 
the previous step this can be most easily distinguished by the change in the Absolute 
values from the Triggered Phase data.  

37. Record the sixth-to-last N-triggered Phase Absolute value in Table 8. 

38. Scroll to the bottom of the Event Table until the end of the G-triggered data is 
reached. These will all show up as NG for Triggered Phase.  

39. Record the sixth-to-last N-triggered Phase Absolute value in Table 8. 
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Table 8. Impulse Verification Inputs 

Applied 
Voltage 
[Vrms] 

Expected 
Reading 

[Vpk] 
Channel 

Measured Magnitude 
|Vpk| 

Limits 
[Vpk] 

800 1131 AN (A)  ± 77 

850 1202 BN (B)  ± 80 

900 1273 CN (C)  ± 84 

950 1344 NG (N)  ± 87 

1000 1414 NG (G)  ± 91 

Calibration 

Required Equipment 
The required equipment and cables for calibrating the Recorder are listed in Tables 2 and 
3.  

XWWarning 
To avoid electrical shock, personal injury, or fire: 

• Do not perform the calibration procedures or calibration 
verification tests described in this manual unless you are 
qualified to do so. 

• Repairs or servicing should be performed only by qualified 
personnel. 

Calibration Adjustment 
The Recorder features closed-case calibration adjustment using known reference sources.  
During calibration, the Recorder measures the applied reference source, calculates 
correction factors, and stores the correction factors in nonvolatile memory. 

Perform calibration adjustment if the Recorder fails any performance test in the 
verification procedure. 

Note 
Calibration should be performed under ambient temperature conditions 
between 20 °C and 30 °C.  

Calibration consists of four parts: I-Wave, I-Rogowski, V-Wave, and V-Impulse. Each 
part calibrates one measurement system in the Recorder. For each part, the calibration 
values are checked to be sure the Recorder is working correctly and calibration results are 
valid. All of the calibration steps for each of the four measurement systems must be 
completed before the calibration values can be written to the Recorder’s nonvolatile 
memory. 

I-Wave, I-Rogowski, and V-Wave channels are calibrated using 55 Hz sine wave signals 
to minimize 50 Hz or 60 Hz power line interference with the calibration measurements. 

V-Impulse channels are calibrated using dc voltages, averaging calibration measurements 
to suppress power line interference. 

Calibration is controlled by 1750 Cal Wizard Software (Cal Wizard), which 
communicates with the Recorder over Ethernet. Cal Wizard steps through the calibration 
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procedure, with instructions for making cable connections, setting the correct sources, 
and finalizing the calibration. 

The following steps detail the calibration adjustment procedure: 

1. Connect the Recorder and the PC to the network with an Ethernet cable. This can 
either be by direct connection or via a hub on an Ethernet network. 

2. Connect ac power to the Recorder. Make sure the Recorder, calibrator, and PC 
running Cal Wizard software are all properly connected to safety ground.  

3. Allow the calibrator and Recorder to warm up (30 minutes for the Recorder). If 
necessary, run Ohms-Cal or Zero-Cal on the calibrator. 

4. Reset the calibrator. Confirm the following calibrator state: 0 V, Standby (OPR LED 
off), EARTH Off (LED off), and EXGRD Off (LED off). 

5. Start Cal Wizard. 

6. With Cal Wizard, select the Recorder to be calibrated, and then click Connect.   

Note 
If the Recorder is password protected, the correct password must be 
supplied to continue. 

7. Click Next. 

8. Follow the on-screen instructions to perform each of the four calibration types. If any 
of these procedures report a failure, the Recorder must be returned for inspection and 
service. See Contacting Fluke. 

9. If all calibrations are successful, click Apply to store the correction values in the 
Recorder memory. This will take up to a minute to complete. 

10. Click Finish. The Recorder will shut down and restart using the new calibration 
values. This may take several minutes. 

This concludes Recorder calibration. 
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Test Cables 
The following figures detail the assembly of cables used for calibrating the Recorder. 

 
fdo02.eps 

Figure 2. Ground Calibration Cable 
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fdo01.eps 

Figure 3. Rogowski Calibration Cable 



1750 
Calibration Manual 

18 

 

fdo05.eps 

Figure 4. Rogowski Resistor Measurement Cable 
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fdo03.eps 

Figure 5. Voltage Calibration Cable 
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fdo04.eps 

Figure 6. Current Calibration Cable 
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